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Report Designer
Can't customize a report to suit your needs? Are you a technology enthusiast? If you answered "yes" to both of
these questions, Report Designer may be right for you.
Report Designer lets you create customized reports from scratch. Report Designer provides powerful query and
design functionality to help you create in-depth, professional reports. It also provides a way to organize your
reports and leads you through the initial report-building steps.
If you are new to Report Designer, check out the overview and the learning tutorial. You can also select or
search for a topic below.

Technical Expertise Required
Report Designer has awesome powers of customization, but the trade-off is a learning curve. Working
with Report Designer requires a fair amount of technical knowledge.
If you find that Report Designer isn't the right tool for you, we also offer professional report
customization for a fee. If you are interested, please contact Support.
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Overview of Report Designer
With ACS Report Designer, you can
Save the Reports You Design — Reports you create are associated with specific modules in Report
Designer. Once you save a report, you can retrieve it, edit it, and save it with a new title.
Use ACS Advanced Exports to Specify the Data Source — The Data Source options lets you create a
new export to use with the report you are designing. Or, you can use an existing ACS Advanced Export
as the data source. When you work with the report, you can edit the export and refresh the export's data.
Sort Data — You can sort the data returned in the report based on the fields you select in Report Options.
Import and Export — Report Designer includes import and export functionality so that you can share
reports between organizations and send and receive reports from ACS Support.
Use the Query Wizard and Quick Design Tools — Report Designer has a Query Wizard and Report
Wizard to help you with data retrieval and report design. The Query Wizard walks you through selecting
tables, fields, calculations, groupings, rows, and sort order. The query selections determine what data
displays in your report.
Complete Learning Tutorials to Learn Report Designer — Before you begin creating reports, set aside a
day to complete the tutorial guide provided with the software. Completing the guide familiarizes you with
many of the tools and concepts found in the Report Designer and is an excellent reference when building
your own reports.
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Report Designer Learning Resources
The Design Workspace of ACS Report Designer is provided by Digital Metaphor's software, Report Builder. For
detailed instruction on using Report Builder, see the Digital Metaphors help below. Please note that ACS uses
Report Builder Enterprise version 10.09. These help links may be for different versions of Report Builder.
If you think you would benefit from personalized training with Report Designer, check out our1-2-1 Online
Training
services, which are available at additional cost.

Report Designer Tutorial Guide
Use the Report Designer tutorial guide to familiarize yourself with basic report building tasks and advanced
report-building techniques. The guide is a series of tutorials that use a sample database to teach you how to
create reports from start to finish. The tutorials begin with the basics, such as adjusting bands, and ends with
advanced reporting techniques, like crosstab creation.

Set Aside a Day
Before you begin designing reports, set aside a day to complete the tutorials. Keep in mind that they
build on one another, moving from basic concepts to complex reports. Therefore, it may be difficult to
complete an advanced tutorial without having first completed earlier lessons. Each tutorial produces
some kind of report using important aspects of Report Designer.

To use the Report Designer tutorial guide, download and install the setup file first.
To install the tutorial guide setup file
1. Click here to download the setup file.
2. Once it is downloaded, open the file.
3. Follow the instructions in the setup window.
When you finish installing the tutorial guide, you can being using it.
To use the tutorial guide
1. In the ACS Report Designer Tutorial folder, open the Learn Report Designer Guide.
2. Start reading. When it prompts you to try a task, open the Learn Report Designer file. This is a
standalone version of Report Designer that includes sample data. Use it to complete the tutorial lessons.
3. If you need further instruction, open the Learn Report Designer Help file.
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Additional Information
This tutorial guide is for an earlier version of Report Designer. Please keep in mind that the steps for
accomplishing tasks, as described in the guide, may differ from the current version of ACS Report Designer. For
help with design in the current version, see Designing Reports.

Report Designer Calculations Help
Report Application Pascal (RAP) is the programming language used for formula calculations in the Report
Designer. The RAP user guide provides useful information on the functionality found on the designer's Calc
workspace and on the Calculations menu option associated with the Variable report component.

Technical Expertise Required
This section contains programmer-level help. Although some of the information is not relevant for
typical Report Designer users, the reference material is helpful when using the calculation features of
Report Designer.

To access the RAP user guide
1. Click here to download the RAP user guide.
2. Once the file is downloaded, open it.

Report Designer Programmer Level Help
The link below opens a help file containing information about Report Builder, the program that ACS Report
Designer is built on. This help file provides information relevant to those familiar with Delphi programming.

Technical Expertise Required
This help focuses on computer programming. We recommend it only for users who have experience
with the Delphi programming language.

To access the Report Builder user guide
1. Click here to download the Report Builder user guide.
2. Once the file is downloaded, open it.

7

Report Designer Workspaces
Report Designer contains four distinct workspaces with different tools for creating professional reports:
The Design Workspace
The Preview Workspace
The Data Workspace
The Calc Workspace

The Design Workspace
When you select Design Reports, Report Designer defaults to the Design workspace. This is where you spend
the majority of your report-building time. The Design workspace is divided into two areas: the workbench and the
canvas. The workbench is comprised of toolbars, component palettes, rulers, and other tools that you can use
to manipulate the canvas. The canvas is the area that contains the report layout. This is where you place bands
and components that ultimately control the content of each page of the report.
The canvas is made up of the header, detail, and footer bands. The header band displays at the top of each
page of the report, the detail band makes up the body of the report, and the footer band displays at the bottom of
each page of the report.

The Preview Workspace
The Preview tab plays an integral role in creating reports. It displays the report on the screen in its printed
format. As your report develops, you can access the Preview workspace to see how it is shaping up. You can
make changes and corrections based on the report's appearance. Using the tools in this workspace, you can
view each page of the report or zoom in to get a better look at a specific page. You can also print the report in
the Preview workspace.

The Data Workspace
Use the Data workspace to select and manipulate data for a given report. In most cases, you will not need to
use the Data workspace because the Report Designer interfaces with ACS Advanced Export to select data for
your report. You can use an existing Advanced Export or create a new one, depending on your reporting needs.
This method of data selection simplifies the query process and makes it easier to select data without an in-depth
knowledge of databases. Using ACS Advanced Export to select data eliminates the need to use the query
functionality of the Data workspace when you are designing a report.
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The Calc Workspace
Report Application Pascal (RAP) is the programming language used for formula calculations in the Report
Designer. The RAP user guide provides
useful information on the functionality found on the designer's Calc workspace and on the Calculations menu
option associated with the Variable report component.
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Creating Reports with Report Designer
You can open Report Designer in the ACS Reports window or in the ACS program menu.
To open Report Designer in the ACS Reports window
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer.
3. Click Go

.

To open Report Designer in the ACS program menu, click Start > All Programs > ACS Technologies >
Report Designer.
After you have opened Report Designer, you can create a new report or modify a standard report.

Creating and Modifying Reports
Report Designer provides several pre-designed standard reports based on frequently used ACS reports. To
quickly report your latest data, you can use these reports as they are. You can also modify a standard report and
save it under a different name.
For a complete list of standard reports, see Available Report Designer Types. If the standard reports don't meet
your needs, you can create a new report from scratch.
Whether you create a new report or modify an existing one, the process includes three overall steps:
1. Selecting a data source
2. Setting the data sort order
3. Designing the report
After you have customized a report, you can save it. If you've created and saved several new reports, you may
want to organize them. You can also import a designed report or modify a report template that you saved
previously.
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Available Report Designer Types
Report Designer includes the following report types, depending on what ACS modules you have.
You can create a new report for any of these report types, or you can modify standard reports to fit your specific
needs.
Module

Report Name

Report Description

People

Create a New

Allows you to create a custom report.

Report
People

Individual

Create a blank Request for Information form to have members and/or

Request for

prospects complete to help with data entry.

Information —
Blank
People

Individual

Create a Request for Information form for selected individuals, with the data

Request for

for each person filled in.

Information
with Data
People

People

People

Master Listing

Creates a list of selected individuals. The list includes name, home, and work

of People

phones, gender, marital and member status, date joined, and date of birth.

Master Listing

Creates a list of selected individuals with their phone numbers and e-mail

of Phones

addresses. Also included are phone number descriptions, extensions, and if

and E-mails

the number is listed or unlisted.

Names and

Creates a list of selected individuals and selected Special Fields.

Special Fields
People

People

One-Line

Creates a list of individuals, along with primary address and phone number.

Phone List

The Head and Spouse names are printed on the same line.

People

Creates a profile report for each family. Along with printing the family address

Profiles

and phone number, demographic data is printed for each family member.

Organizations Create a New

Allows you to create a custom report.

Report
Organizations Contributing
Churches
Organizations Organizations

Creates a report of selected organizations with their year-to-date totals for the
last seven years.
Creates an extract of organizations and staff members, including organization

Staff Directory and meeting addresses, phone and fax numbers, and e-mail addresses.
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Module

Report Name

Organizations Remitters

Report Description
Creates a report that includes the church names, PIN, address, and the

Summary

funds(s) they have pledged for a selected year/date range and the YTD total

Report

pledge and pledge balances remaining on the fund(s).
The report only tracks organization records, not staff.

Contributions

Create a New

Allows you to create a custom report.

Report
Contributions

Contributions

Contributions

Creates a separate letter for each selected contributor with a summary of

Merge Letter

their contributions to each fund for the year.

Gift List Detail

Creates a detailed list of transactions for each selected contributor. Details
include posted date, fund, gift amount, check number, value of service, and
gift description. Prepayments made in previous years are not included.

Contributions

Pledge

Creates a detailed list of pledges for selected contributors for a selected year.

Details Listing

This includes pledge amount, frequency, term, start date, prepayments, total
pledge amount, and pledge-to-date amount.

Attendance

Create a New

Allows you to create a custom report.

Report.
Connections

Connections

Contacts by

Creates a list of contacts per individual. This includes the type of contact

Contact Date

made and notes linked to the contact.

Create a New

Allows you to create a custom report.

Report.
Reservations

Create a New

Allows you to create a custom report.

Report.
Checkpoint

Create a New

Allows you to create a custom report.

Report.
Special

Create a New

Mailings

Report.

General

Create a New

Ledger

Report.

Allows you to create a custom report.

Allows you to create a custom report.
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Modifying a Standard Report
You can modify a standard report in Report Designer to better fit your organization's needs and save it under a
different report name. Study the standard report thoroughly and determine what changes you need to make
before accessing the report to make changes. This will save you time during the editing process and reduce the
chance of error.
To modify a standard report
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer and click Go

.

3. In the upper sidebar, select Contributions, Connections, People, or Organizations.
4. In the Reports list, select the standard report.
5. In the lower sidebar, click Customize.
6. Modify the data source, sort order, and report design.
After you have modified the report, you can save it.
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Creating a Data Source
The first step in creating a new report is selecting the data that it pulls. You can choose from several methods for
retrieving report data:
Create a Data Export — Interfaces with ACS Advanced Export in Searches. You can use the Data
Export Designer to create a new data export for your report.
Import an ACS Advanced Export — Imports an existing ACS Advanced Export.
Create an Org Staff/Activities Extract — Pulls staff, activities, and other organization data from the
Organizations module.
Create a People Direct Datasource — Pulls People data from a specific dataset.
Create a Financial Direct Datasource — Pulls Financial data from a specific dataset.
After you have selected the data source, you should set the data sort order.

Creating a Data Export
Uses the Advanced Export functionality in Searches to create a data export for your report.
To create a data export
1. On the Report Options tab, click Get Report Data.
2. Select Create a Data Export.
3. In the Select Export Type window, select one of the following:
File Export — This option enables you to create a single file containing selected export
information. If you are unsure of which export type to choose, select this option.
Database Export — This option enables you to create multiple files that are linked by common
fields.
4. Click OK. The ACS Data Export Designer displays.
5. Optional: Click Description to enter a description of the export.
6. On the Groups and Fields tabs, manage the options to your liking.
7. Click Save & Close. The export is generated automatically.
8. A message displays indicating that you can limit the number of records exported. Do one of the following:
To limit the number of records exported, enter the maximum number of records to export and then
click OK.
To export all records, click OK.

Importing an ACS Advanced Export
You can import an existing Advanced Export to retrieve data for your report.
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To import an ACS Advanced Export
1. On the Report Options tab, click Get Report Data.
2. Select Import an ACS Advanced Export.
3. Select the advanced export file.
4. Click OK.
5. A message displays indicating that you can limit the number of records exported. Do one of the following:
To limit the number of records exported, enter the maximum number of records to export and then
click OK.
To export all records, click OK.

Creating an Org Staff/Activities Extract
You can extract Organizations data into Report Designer. You must have the Organizations module to use this
option.
To create an Organizations Staff/Activities extract
1. On the Report Options tab, click Get Report Data.
2. Select Create an Org Staff/Activities Extract.
3. Under Date Selection, select the Effective Date.
4. To include only active staff in the extract, select Include Active Staff Only. (Otherwise, both active and
inactive staff are included.)
5. Under Staff Phone/E-mail Settings, select the data you want to export for:
Business Type
Mobile Type
Pager Type
Fax Type
E-mail Type
6. Under Include Activity Groups, select Include All to include all Activity Groups. Or, select only the
Activity Groups you want to include.
7. Click Save.

Creating a People Direct Datasource
If you have more than one ACS Financial Suite dataset, you can select a specific dataset as your report data
source. If have only one dataset, it is selected as the People Direct Datasource by default.
To create a People Direct Datasource
1. On the Report Options tab, click Get Report Data.
2. Select Create a People Direct Datasource.
3. To include archived datasets in your list of options, select Include Archived Datasets.
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4. Select the dataset.
5. Click OK.

Creating a Financial Direct Datasource
If you have more than one ACS People Suite dataset, you can select a specific dataset as your report data
source. If have only one dataset, it is selected as the Financial Direct Datasource by default.
To create a Financial Direct Datasource
1. On the Report Options tab, click Get Report Data.
2. Select Create a Financial Direct Datasource.
3. To include archived datasets in your list of options, select Include Archived Datasets.
4. Select the dataset.
5. Click OK.
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Editing Data Export Options
Once a report is associated with a data source, you can edit the data export. For example, you may want to
modify the data export of a standard or saved report.

Create Data Source First
The editing data options are only available when the report is already associated with a data source.
The specific edit options available depend on the chosen data source. If the edit options are not
available, you must create a data source first.

To edit data export options
1. On the Report Options tab, click Get Report Data.
2. Select the edit option associated with the chosen data source.
3. When the Data Export Designer displays, make the changes to the export and click Save & Close.
4. A message displays indicating that you can limit the number of records exported. Do one of the following:
To limit the number of records exported, enter the maximum number of records to export and click
OK to refresh the data.
To export all records, click OK.
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Refreshing a Data Source
Once a report is associated with a data source, you can refresh the data for the report. This ensures that your
reports contain the most recent data retrieved in the export.
Using the refresh option, you can also limit the number of records exported so you can work with a smaller
subset of the data while designing your report. This decreases the time it takes to process data before you
design the report. After you have finished the report design, you can then export all records.
You can refresh data at any time. When you create a data export, import a data export, or edit data export
options, the program prompts you to refresh data. You may also be prompted to refresh data when you set the
data sort order or click Design Report.

Useful Information
The refresh option is available when the report is associated with a data source. If the option is not
available, you must create a data source first.

To refresh data for the data source
1. On the Report Options tab, click Refresh Data.
2. A message displays indicating that you can limit the number of records exported. Do one of the following:
To limit the number of records exported, enter the maximum number of records to export and click
OK to refresh the data.
To export all records, click OK.
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Setting the Data Sort Order
Once you have created the data source for your report, you can set the sort order of the data. Setting the sort
order is especially important for reports that include vast amounts of data. It makes locating information within
the report much easier.
When you set the data sort order, you select what fields to sort the report by. The first field in the list is the
primary sort criteria: the data is sorted by this field first. You can choose additional fields to sort by, up to a max
of 15.
For example, you generate a report of all the people in your dataset. Your first sort field is Member Status. This
is helpful because it sorts everyone into the status of member, visitor, contributor only, and so on. However,
whether you have 80 or 8,000 members, you need further organization within these categories. So, you select
Last Name as the second sort field. This way, the report is sorted first by member status, but the names within
each status are also sorted by last name.
To set the data sort order
1. On the Report Options tab, click Set Data Sort Order.
2. In the Available Fields list, double-click the first field. It then displays in the Sort Report by list.
3. If you prefer, select another field to sort by. You can select a max of 15 fields.
4. To re-arrange the order of fields, click Move Up and Move Down.
5. To remove a field from the Sort by list, select it and click Remove.
6. You can specify whether the data is sorted in Ascending (A...Z, 1...10) or Descending (Z...A, 10...1)
order.
7. When you are finished, click OK.
Once you have set the data sort order, you can design the report.
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Designing Reports
Once you have selected data for your report and set the sort order, you can design your report. You do this by
creating a layout of objects that describe how the document will look.
To start designing a report
1. On the Report Options tab, click Design Report.
2. A message displays indicating the last time the data was exported and gives an option to limit the number
of records exported. Do one of the following:
To limit the number of records exported, enter the maximum number of records to export and click
Yes to refresh the data.
To export all records and refresh the data, click Yes.
If you do not want to refresh the data, click No.
The Design Workspace opens.
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Customizing the Page Setup in Report Designer
In Report Designer, you can customize the page setup to change your paper size and margins, print in portrait
or landscape orientation, and choose the number of columns for your reports. These options are for both viewing
and printing reports.
To customize the paper settings
1. On the Report Designer menu, select the report.
2. Click Customize and select your Data Source and Report Options.
3. Click Design Report > OK.
4. Click File > Page Setup.
5. Select the Paper tab.
6. Select the Printer Name.
7. Select the Paper Size, and enter or select the Width and Height.
8. Select the Paper Source.
9. Click OK.
To customize the margins
1. On the Report Designer menu, select the report.
2. Click Customize and select your Data Source and Report Options.
3. Click Design Report > OK.
4. Click File > Page Setup.
5. Select the Margins tab.
6. Under Margins, enter the values you want for each margin, or click the arrows to select these values.
7. Under Orientation, select Portrait or Landscape.
8. Click OK.
To customize the columns
1. On the Report Designer menu, select the report.
2. Click Customize and select your Data Source and Report Options.
3. Click Design Report > OK.
4. Click File > Page Setup.
5. Select the Columns tab.
6. Enter the number of columns that you want, or click the arrows to increase or decrease the number of
columns.
7. On the Columns tab, select additional options.
8. Click OK.
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Combining Two Fields on a Report
For some reports, you may want to combine two ACS fields into one. For example, you may want to print names
in First Name + Last Name format (for example, Jane Aaron). You can do this in Report Designer by using a
Variable component

. To do this, first create a sample report with your ACS data. Then, you can combine

the first and last name fields.
To create a new report
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer and click Go

.

3. In the Report Type list, select the People report type, then select Create a New Report.
4. In the lower sidebar, click Customize.
5. Click Get Report Data > Create a Data Export.
6. In the Select Export Type window, select Database Export and then click OK. The ACS Data Export
Designer window displays.
7. On the Groups tab, select People.
8. Click the Included Data tab and then select Personal.
9. Click Save & Close.
10. In the Refresh Export window, enter the number of records you want to limit the export to and then click
OK.
11. On the Report Options tab, click Design Report.
12. In the New Items window, click Cancel.

To combine the First Name and Last Name fields
1. In the design workspace, click Variable

.

2. Click in the Detail band to place a Variable component in the report.
3. Right-click the Variable component and then select Calculations... .
4. In the Code Toolbox: Data section of the Calculations window, select People.
5. On the Data tab, click the FirstName field and drag it into the left-hand area of the Calculations window.
The following text displays:
Value := People['FirstName']
6. Type a plus sign, an apostrophe, a blank space, an apostrophe, and a plus sign. The calculation should
now look like this:
Value := People['FirstName']+' '+
7. On the Data tab, click the LastName field and drag it into the left-hand area of the Calculations window.
The calculation should now look like this:
Value := People['FirstName']+' '+ People['LastName']
8. Type a semicolon. The final calculation should look like this:
Value := People['FirstName']+' '+ People['LastName'];
9. Right-click in the left-hand area of the Calculations window.
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10. Select Compile. At the bottom of the window, a message displays indicating any errors in calculation.
11. To return to the design workspace, click OK.
12. To check your calculation, click the Preview tab. The names on the report should look like this:
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Creating a Cover Page for a Report
When you create a report for formal presentation, you may want to add a cover page to introduce your report.
To create a cover page for a report
1. In the design workspace, on the Report menu, select Title.
2. Increase the height of the title band by dragging the divider down until the guide reaches the 9.5 inch
mark on the vertical ruler.
3. Place the components you need to design your cover page in the Title band.
4. Design the cover page.
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Creating a Tabular Report
When you create a tabular report in Report Designer, labels display across the page and data displays down the
page.
To create a tabular report
1. In the design workspace, on the Report menu, select Data Tree.
2. On the Data Tree, click the Layout tab.
3. In the Style list, select Tabular.
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Creating a Vertical Report
When you create a vertical report in Report Designer, labels display down the page and data displays across the
page.
To create a vertical report
1. In the design workspace, on the Report menu, select Data Tree.
2. On the Data Tree, click the Layout tab.
3. In the Style list, select Vertical.
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Creating Labels in Report Designer
You can use the Label Templates wizard in Report Designer to create labels and other items such as name
tags.
To create labels in the Report Designer
1. In the design workspace, on the File menu, select New.
2. In the New Items window, select Label Templates.
3. Click OK.
4. In the Label Templates window, select the appropriate printer and label information.
5. Click OK.
6. Add the desired information to the label in the design workspace.
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Entering Additional Field Descriptions in Report Designer
Your additional lists, fields, and dates are used to print the Individual Request for Information – Blank and
Individual Request for Information with Data reports. Because the lists, fields, and dates are unique for each
organization, the labels on the reports are not auto-populated. You must edit the labels on these reports for the
appropriate information to display.
Once you have a list of your additional data, you can enter the descriptions in the report labels.
To obtain a list of your additional lists, field, and dates
1. Under Manage Records, click the People tab.
2. In the drop-down list, select View/Edit Individual and click Go

.

3. Select a record and then click View/Edit.
4. Click the Additional Fields tab.
5. Click the Family tab.
6. Print this screen or write down the field names.

Note
Make sure you copy the field names in the exact order that they appear, including any fields
labeled Not Defined. The fields appear in the same order on the Individual Request for
Information reports, so you need to keep them in the appropriate order to know which field is
which.

7. Click Close.

To enter descriptions for your additional fields
1. Open Report Designer,
2. Select the specific Individual Request for Information report.
3. In the lower sidebar, click Customize.
4. On the Report Options tab, click Design Report.
5. The additional fields, lists, and dates are labeled Open Category, Open Field, or Open Date. Click the
first label to select it.
6. Enter the label for the additional field in the Set Value box located on the toolbar.

Useful Information
If any of your additional fields, lists, or dates are Not Defined, you can make the label and blank
next to it visible by right-clicking the component and clearing the Visible option.
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7. Repeat step 4 for each additional field, list, and date on the report.
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Inserting an Image in Report Designer
When designing a report, you can insert images. You can insert images from your computer, such as your
church's logo, and you can also insert family and individual photos from the ACS database.
To insert an image
1. In the design workspace, on the Standard Components toolbar, click Image

.

2. Place the Image component in the appropriate position in the Detail band.
3. Right-click the Image component and select Picture... .
4. Select the image file you want to include from the appropriate directory.
5. Click Open.
To insert a family or individual photo
1. On the Design tab, click RDDBImage

.

2. Place the field in the location that you want in the Detail band.
3. From the Data Field drop-down list, select the picture type that you want to include.
4. Right-click the picture field, then select MaintainAspectRatio.
5. Right-click the picture field then select Stretch.
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Report Bands
When you create a Report Designer report, you do a significant amount of work in the canvas. The canvas is
divided into sections called bands. A band is labeled in the section divider immediately below it; thus, the first
band is called the Header, the second is called the Detail, and the third is called the Footer. When the report
generates, the bands are printed on different parts of the page.
The bands available for use when creating a report are:
Header — Components placed in the header band print at the top of each page of the report.
Detail — Components placed in the detail band make up the body of the report.
Footer — Components placed in the footer band print at the bottom of each page of the report.
Title — Components placed in the title band print at the beginning of the report, displayed as a title.
Summary — Components placed in the summary band print at the end of the report, such as a total
record count or total amount.
Page Style — A page style can be designed just like a report band, but it generates as a background to
the bands of the report. Page Styles are used to produce forms.
Group Header — Components placed in a group header band print at the beginning of a group of
information.
Group Footer — Components placed in the group footer band print at the end of a group of information.

Adjusting Report Bands
The bands of your report can be adjusted to accommodate the size of larger components, or additional
components, as necessary. For example, if you want to increase the height of the header band to accommodate
a large logo or table title, you can do so using the ruler on the left-hand side of the Design workspace.
To adjust a report band
1. Place your cursor on the divider label for the band to adjust. For example, if you want to adjust the
Header band, place the cursor over the Header divider label. The cursor changes to an up/down arrow,
indicating that you can drag the divider up and down.
2. Hold down the left mouse button and drag the divider up and down to adjust the size.

Useful Information
Notice the two lines that display on the vertical ruler to the left of the divider. These lines are called
"guides" because they represent the new position of the divider.
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Report Components
A report component is an element used to control how a report looks. Each component has a unique purpose.
There are four types of components used in Report Designer:
Standard Components
Data Components
Advanced Components
Check Box Components

Standard Components
The Standard Components in Report Designer are the components that are most frequently used to build
reports. The standard report components include items such as labels, memo, and images. These components
do not retrieve data from your database to display. Rather, you assign the content that a standard component
displays when you are creating the report.

Data Components
The data components in Report Designer are similar to the standard components. The difference is that data
components are data-aware, meaning that they have the ability to read the value of a field from a database table
and then display that value in the report. You associate a data-aware component with a database table and field
by selecting the data pipeline and the data field from drop-down lists in the edit toolbar.

Advanced Components
The advanced components help you with complex reporting requirements. You can create regions, subreports,
and crosstabs using advanced components. See Advanced Component Selection.

Check Box Components
CheckBox components in Report Designer are components that can be used to place marked or unmarked
check boxes in a customized report. CheckBox components help you to avoid having to manually draw your
check boxes, and can be used in a variety of ways. You can use CheckBox components to display a constant
marked or unmarked value in your report. You can also configure CheckBox components to retrieve data and
display as marked or unmarked in your report based upon the selected Boolean value. The two types of
CheckBox components available in Report Designer are CheckBox and DBCheckBox.
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CheckBox
You can use the CheckBox component to display either a constant checked value or an empty check box on
your report. For example, if you wanted to create a basic group list for an activity or event to determine which
individuals would be willing to participate, you could place an unchecked CheckBox beside each of the individual
records on your report and then mark each of the participating individuals as they sign up. Once you have
placed a CheckBox component on your report, you can use the Edit toolbar to select the type of checkbox that
you want and right-click the CheckBox component to access the Checked speed menu option.

DBCheckBox
You can use the DBCheckBox component to read the value of a field from a database and display a checked or
unchecked box based upon the values you select on the Checkbox Settings window. Once you have placed a
DBCheckBox component on your report, you can use the Edit toolbar to set the data pipeline and select a data
field for the check box.
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Advanced Component Selection
When you are using a shape component as a background for a band, you need to use specific techniques to
select multiple components while using a bounding box in front of that background shape. The bounding box
method described in the Basic Component Selection topic does not apply when you use a component as a
background.
To select multiple components using a bounding box
1. Hold down the Ctrl key.
2. Click on the white space to the left of the first component.
3. Hold down the left mouse button.
4. Drag the mouse until the box encloses all the components.
When you release the mouse, all of the components are selected. Notice that the background component is also
selected.

To clear the background component
1. Hold down the Shift key.
2. Click the component.

To clear the components
Click in the white space of another band. Or, click a deselected component.
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Aligning Components
When you are designing a report, there are components that must be aligned with each other. For example, if
you are using three labels in your Header, you may want to align them by the top or bottom of the component
boxes. You may also want to left-align each label component with its corresponding DBText component.
To align components
1. Select one of the components to align and adjust its position appropriately.
2. Press and hold the Shift key.
3. Select the other components.
4. Release the Shift key. Notice that all of the components stay selected.
5. Click the appropriate alignment icon for the type of alignment you want to perform. For example, if you
are aligning your label components at the top of each label component box, click Align Top

.

All selected components are aligned with the first component.
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Basic Component Selection
Once the components of your report are created, you need to carefully position them to create a high-quality
report. To position components, you need to understand component selection in Report Designer. Here are
some tips for selecting components in Report Designer.
Select a component by clicking it. The selected component should look like this:

To select additional components, hold down the Shift key and then click the other components. All of the
additional components, and the original component, should now be selected. You can tell that they are
selected by the small gray boxes surrounding each component. These boxes are called selection
handles.

You can select multiple components using a bounding box. To select components using a bounding box,
click in the white space to the left of the first component, hold down the left mouse button, and drag the
mouse until the box encloses all the components. When you release the mouse, all the components are
selected. If you place your cursor over one of the components and drag it in any direction, all the selected
components move in unison. This is called a component selection.

Click in the white space of any design band to deselect components.
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Bolding Text in Components
Useful Information
When saving a Report Designer report as PDF using Print to File, select the Embed All Used Fonts
option on the Compression & Font Encoding tab. Selecting this option ensures that the fonts remain in
bold type.

To bold text in components
1. Select the component(s) you want to display in bold type. Small gray boxes, called selection handles,
display around each component to indicate that it is selected.
2. Click Bold

. All selected components display in bold type.

Tip
To bold multiple components at once, press and hold the Shift key while selecting the components.

37

Configuring a DBCheckBox Component
You can configure a DBCheckBox component to retrieve data and display as marked or unmarked in your
report based upon the selected Boolean value.
To configure a DBCheckBox Component
1. On the Data Component workspace toolbar, click DBCheckBox

.

2. Click the white space of the Detail band to place a DBCheckBox component in the detail band.
3. Notice that there are two drop-down lists in the upper left-hand corner of the Design workspace. The
drop-down list on the left, the Data Field list, contains the fields selected from the datasets. The
drop-down list on the right, the Data Pipeline Name list, contains the datasets from which you selected
data in the Advanced Export.
4. In the Data Field list, select the data field for the DBCheckBox component. The first field value displays
in the DBCheckBox component.
5. In the Data Pipeline Name list, select the dataset of the field you want to select for the DBCheckBox
component.
6. Right-click the DBCheckBox component to access the Speed Menu.
7. Click Settings. The Check Box Settings window displays.
8. Select a Style for the check box.
9. Enter the Boolean True and Boolean False values that you want.
10. Click OK.
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Creating a DBText Component
A DBText component displays data from a database field you selected in the Advanced Export used for the
report. DBText components cannot handle rich text or images.
To create a DBText component
1. On the Design workspace toolbar, click DBText

.

2. Click the white space of the Detail band to place a DBText component in the detail band.
Notice that there are two drop-down lists in the upper left-hand corner of the Design workspace. The
drop-down list on the left, the Data Field list, contains the fields selected from the datasets. The
drop-down list on the right, the Data Pipeline Name list, contains the datasets from which you selected
data in the Advanced Export.
3. In the Data Field list, select the field for the DBText component. The first field value displays in the
DBText component.
4. In the Data Pipeline Name list, select the dataset of the field you want to select for the DBText
component.

Tip
To see the names of these lists, place the cursor over the field. A tool tip displays the name of the list.
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Front-to-Back Order
In Report Designer, you can use a shape component to create a background for other components. To do this,
you need to establish the correct front-to-back order for components. Front-to-back order refers to the order
components are presented in when they overlap. When you are creating a background for a report band, you
need to position it behind the other components in the band, or "send it to the back." To access the available
options for ordering a component, simply right-click the component.
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Placing and Naming Label Components
A label is a component in the Standard Component Palette that functions as a header for another kind of
component, such as a DBText component. Labels are placed in the header band of the Design workspace so
they print on each page of the report. Proper label naming is important in making your report columns easy to
follow.
To place and name a label in the Design workspace
1. On the Standard Components toolbar, click Label

.

2. Click the white space of the header band to create a label.
3. Locate the Edit toolbar (below the label component icon on the toolbar). It should contain the text
'Label1', which is the caption of the currently selected label.
4. Select the text in the edit toolbar and enter the label name.
5. Repeat steps 1 through 4 to create additional labels for your report.
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Positioning Components
Once you have added a component in the design workspace, you can adjust the position of the component box
to better format your report.
To adjust the position of a component
1. Right-click the component and select Position...
2. Set the appropriate Left position, Top position, Width, and Height of the component.
3. Click Apply.
4. Click OK.

Tip
Use the vertical and horizontal rulers to position components. If the rulers are not visible, in the View
menu, select Rulers. When a component is selected, you can view the measurements of the
component in the lower right-hand side of the status bar.
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Sizing Components
To achieve the best format for reports, you need to resize components. You can make components larger or
smaller, depending on the area you want to use in the report band and what is displayed in the component.
To size a component
1. Make sure all components are deselected: click in the white space of any report band.
2. Select the component.
3. When the component is selected, small black boxes (called sizing handles) display around the box
outline. Place the cursor over the appropriate sizing handle. The cursor becomes a double-arrow. Hold
down the left mouse button and drag the cursor to a new size.

Tip
Use the guides on the vertical and horizontal rulers to determine the position and size of the
component. You can also adjust the size of a component by selecting it, holding down the Shift key,
and pressing the arrow keys. (Use this method to size multiple component selections.
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Sizing a Component Stretched to ParentHeight and ParentWidth
When you have a shape stretched using ParentWidth and ParentHeight, you cannot change the size using the
sizing handles.
To size a component stretched to ParentHeight and ParentWidth
1. Select the component.
2. Right-click the component and select ParentHeight. The ParentHeight menu option is cleared.
3. Right-click the component and select ParentWidth. The ParentWidth menu option is cleared.
4. Use the sizing handles to modify the size of the shape.
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Stretchable Components
The DBMemo is a special class of component called a "stretchable." As the report prints, stretchable
components increase or decrease in height based on their content. This differs from static components, which
always print with the same height. When a band contains both static and stretchable components, it is difficult to
get the printed pages of a report to look exactly right because stretchable components print at a height that is
different from the one given in the report layout. The following properties can help you keep your reports looking
good when you use stretchables.
Property

Function

Stretch

Applies to stretchables only, and indicates whether or not the stretchable will adjust its
height based on content. A stretchable component with Stretch set to False behaves
just like a static component, printing at the height defined in the report layout and
cropping any content which extends beyond that height. When set to True, Stretch
causes the component to adjust its height based on the content.

StretchWithParent

Applies only to shapes and lines and can be used to create a border or background for
a stretchable component. The 'Parent' in StretchWithParent refers to the band, since
the band contains the components.

ShiftWithParent

Used by static components that need to print after a stretchable has completed
printing. For example, let's say you need a description of a car, followed by the price.
The price should display below the description. To do this, you would place a DBText
component below the memo, setting the ShiftWithParent property to True. When the
report prints, the memo would print to completion and then the price would print
beneath it.

OverFlow

Whenever a stretchable is printing on additional pages, it is said to be overflowing.
When a condition of OverFlow exists, other components in the band may print again
in order to clarify the content of the stretchable.

ReprintOnOverFlow This property applies to static components only. Stretchable components often have a
set of static components that put the content of the stretchable into context. For
example, a memo describing the features of a car might be preceded by the name of
the model. If this memo happened to overflow onto additional pages, it might be helpful
to print the name of the model again so that the reader is reminded of the model to
which the description pertains. To do this, you would set ReprintOnOverFlow to True
for the model name.
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Using a Shape as a Background
If you want to add color to your report, you can use a shape as a background for a report band.

Useful Information
While working through this procedure, any components you have in the report band you are working in
will be hidden behind the shape component. They are not deleted; when you complete the procedure,
the components will move in front of the background component.

To use a shape as a background
1. On the Design workspace toolbar, click Shape

.

2. Click in the report band you want to give a background.
3. Right-click the Shape component you created and select ParentHeight. The height of the component
stretches to the height of the band.
4. Right-click the component and select ParentWidth. The width of the component stretches to the width of
the band.
5. On the Draw toolbar, click the Fill Color arrow

.

6. Select the color to use as the background for the band.
7. Right-click the component and select Send to Back.
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Report Designer Groups
A group is a section of a report that contains a group header, detail, and group footer band. It includes records
that have a common value for a field that you have selected to group your data by. For example, if you select
Member Status to group your data by, the reported data displays in groups under each member status.
When working with groups, you should understand these three important concepts:
Data Traversal and Groups
Groups and Sorting Data
Creating Groups

Data Traversal and Groups
Data Traversal
A report is generated based on a database table. A database table is a collection of data organized into columns
and rows. A report document (the pages you see in the print preview window) is created when the report
generates a detail band for each row in the database table. The act of moving from one row in the table to the
next is called data traversal. Data traversal can have a dramatic impact on how the report document is
generated, especially in the case of groups.

Groups
Report groups are represented in the layout by a matched pair of bands: the group header and group footer. The
group header prints when the group begins; the group footer prints when the group has ended. For example,
let's say you want to see the orders received by a business, organized by each month of the year. You would
first create a data selection sorted by month, then you'd create a group based on the 'month' field.

Groups and Sorting Data
Groups
When you create groups, you assign them to a field. As the report generates, the group tracks the value of the
assigned field. If the field value changes when the report moves from one row of the database table to the next,
then the current group ends (the group footer prints) and the next group begins (the group header prints). Group
headers always print at the beginning of a report - in order to start the first group - and group footers always print
at the end of the report - in order to finish the last group.
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Sorting Data
Groups let you organize the report into sets of rows that share a common value. However, groups can only
function if the field they're assigned to has been used to sort the data. If you associate a group with a field, but
do not sort the data by that field, the group will function. That is, the group will generate a group footer and group
header each time the field value changes, but because the data is not sorted properly, the group appears to
generate at random. Whenever you see a group generating too many times, make sure the data is sorted
properly.

Creating Groups
When designing a report, you can create groups that group data based on the value of a specified field. For
groups to work properly, you must set the sort order for your data by the field you want to group by. Make sure
that your data source includes the field you want to group by, and that you sort the data by the field you want to
group by.
To create a group
1. On the Design Workspace Report menu, select Groups.
2. In the Groups list, select the field you want to use to group data. Note:Make sure you select a field that
you are using to sort your data.
3. Click Add.
4. In the Break On section, select Data Field.
5. To start a new page each time the group value changes, in the On Group Change section, select Start
new page.
6. To have the page numbering start over for each group, select Reset page number.
7. To reprint the header information for each group, select Reprint group headers on subsequent pages.
8. Click OK.
9. Add the appropriate components to your group header and footer.
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Report Designer Regions
A region is a special type of component that can contain other components. You can associate a set of
informational components with a single stretching component (such as a memo) in a band using a region. By
placing components in a region that is associated with a stretching component, you can ensure that components
keep their appropriate placements and that stretchable components do not hide them.
The region component moves relative to the stretching component. You place other components in a region by
dragging them into it. When you resize or move a region, the components inside the region shift to
accommodate the changes in the region.
When layouts contain multiple stretching components, and other related components are not printing in the
correct positions, you can often fix this by using regions to logically group components, then assigning the
ShiftRelativeTo property to associate regions with the appropriate stretching component.
When designing a report, you can use a region to associate a set of informational components with a single
stretching component in a band.
To create a region
1. On the Advanced Component toolbar, click Region

.

2. In the Detail band, click in the area where you want to insert a region.
3. Use the sizing handles to size the region appropriately.
4. Select the components you want in the region; drag and drop them into the region area.
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Report Designer Speed Menus
The speed menu displays when you right-click a component. It offers different options for altering the overall
look of your component via changes in shape, size, and visibility. The speed menu varies slightly for different
components.

Useful Information
When you open a speed menu, it applies only to the component you right-clicked, regardless of any
components you have selected.

The options listed below are available on the speed menu. Different options are available for different types of
components.
Speed Menu Option

Description

AutoDisplay

AutoDisplay is a speed menu option available for DBMemo and DBImage
components.
If you have a file path stored as a field in your database for an image or text file
you want to use, you can set AutoDisplay to true so that the component
automatically displays new data when the information for the field changes.

AutoSize

AutoSize is a speed menu option available for text components. When
AutoSize is set to true, the component adjusts its width so that all of the text
displays.

AutoSizeFont

AutoSizeFont is a speed menu option available for Bar Code components. By
default, the human readable text is set to a standard accepted font size based
on the size of the barcode component. Deselect the AutoSizeFont option to
manually select the font size.

BlankWhenZero

If the value of a field you have selected is equal to zero, you can print a blank
instead of a "0" for the field by selecting the BlankWhenZero option.

Bring to Front

Bring to Front moves an object in front of other objects. This option controls the
appearance of overlapping objects.

Calculations...

The Calculations speed menu option accesses a Calculations area where you
can set up calculations for a component.

Center

Center is a speed menu option available for image components. Select this
option to center an image in the report band.
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Speed Menu Option

Description

CharWrap

The CharWrap speed menu option determines if the individual characters of a
word will be wrapped to the next line when a single word does fit within the width
of the control.

Checked

The Checked speed menu option is used to display a check in a CheckBox
component.

Configure...

The Configure speed menu option is available for bar code components. Use
this option to select properties such as the Bar Code Type, Orientation, Bar
Width, and Wide Bar Ratio.

DirectDraw

DirectDraw is a speed menu option available for image components. Select this
option to send an image directly to the printer. If you have a problem with an
image printing correctly, selecting DirectDraw may correct it.

DisplayFormat...

DisplayFormat is a speed menu option available for textual components. This
option enables you to display a value in a certain format (decimals with a dollar
sign, for example).

Double

Double is a speed menu option available for line components. Select this option
to print double lines.

Edit

Edit is a speed menu option for a Rich Text component that opens a dialog
used to open a file and format text.

Force Justify

The Force Justify speed menu option is used to force the justification of text in
a component.

GraphicType

GraphicType indicates the type of graphic image you are loading from the
database. The options available are Bitmap, Icon, Metafile, JPEG, and GIF.
Bitmap is the default graphic type.

KeepTogether

KeepTogether controls the pagination of a component when the contents
cannot fit on one page.
Normally, the contents print to the end of the available page space and continue
on subsequent pages until complete. If you use KeepTogether, the entire
component moves to the next page if all the contents do not fit on the current
page.

Lines...

This memo speed menu option accesses the Memo Editor, from which you can
open text only files.

MailMerge

MailMerge displays when you right-click over a Rich Text component. It enables
you to import field values into the Rich Text component.
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Speed Menu Option

Description

MaintainAspectRatio

MaintainAspectRatio is a speed menu option available for images. It scales an
image so that the height and width are adjusted based on the original image
size.

ParentHeight

ParentHeight is a speed menu option used to set the shape of an object so that
it matches the height of a band.

ParentWidth

ParentWidth is used to set the shape of an object so that it matches the width
of a band.

Picture...

The Picture speed menu option is available for image components. Use the
Picture option to select the picture file you want to use as an image.

Position...

Position is a speed menu dialog used to change the size of an object.

PrintHumanReadable

The PrintHumanReadable speed menu option is available for bar code
components. Use it to print the human readable version of a bar code (the
actual letters or numbers). Bar codes like UPC-A and EAN-13 should always
use this option. Other types of bar codes do not require it.

ReprintOnOverFlow

ReprintOnOverFlow is a speed menu option that applies to static components,
or components that always print at the same height. These types of components
are frequently used with stretchable components because they serve the
purpose of a heading.
For example, if a memo prints on several pages, the heading component should
print with it. Set the heading component to ReprintOnOverFlow so that it prints
on each page.

ReprintOnSubsequent

The ReprintOnSubsequent option is used in conjunction with the
SuppressRepeatedValues option. When you are suppressing repeated values,
you can force a field to reprint on the first detail line of the new page by selecting
this option.

ResetGroup...

The ResetGroup option is used to set a control group for a report calculation.
To set the control group, you specify a field as the group's BreakName, and
when the field value changes, the DBCalc control is reset to zero and the
calculation begins again.

Send to Back

Send to Back is frequently used with shapes. This speed menu option moves
components to the background. If you want to use a shape as a background,
use the Send to Back function.

Settings...

The Settings option is used to access the Checkbox Settings window. You can
use this window to select the style and Boolean values for a DBCheckBox
component.
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Speed Menu Option

Description

ShiftRelativeTo...

ShiftRelativeTo is a speed menu option available for the following components:
Memo, DBMemo, RichText, DBRichText, and Region. This option associates
these components with one another so that one can print directly after another.

ShiftWithParent

ShiftWithParent is used to print a static component after a stretchable
component.

Single

Single is a speed menu option available for line components. Select this option
to print a single line.

Stretch

This menu option applies to stretchable components only. When Stretch is not
selected, the component behaves just like a static component: it prints the same
height each time, regardless of text.
When Stretch is selected, the component adjusts according to the amount of
printing text.

SuppressRepeatedValues This speed menu option prevents repeated values from printing for DBText and
DBCalc components.
Timing...

The Timing speed menu option is used to set the timing of calculations.

Transparent

The Transparent option determines whether the background of a report
component is clear or opaque. This option defaults to opaque.

Visible

This speed menu option determines the visibility of an object.

WordWrap

The WordWrap option determines whether the text in a component has line
breaks on words so that the text fits inside the boundaries of the component
instead of truncating.
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Report Designer Toolbars
Report Designer has several toolbars, component palettes, and data trees to help you design a report:
Nudge Toolbar
Size Toolbar
Draw Toolbar
Align or Space Toolbar
Standard Component Palette
Data Component Palette
Advanced Component Palette
Report Tree
Data Tree
Standard Toolbar
Format Toolbar
Edit Toolbar
To view a list of all toolbars in Report Designer, on the View menu, select Toolbars. Or, right-click over the gray
area of the workbench.

Nudge Toolbar
Use this toolbar when you want to move a component or selection of components with extreme precision. Each
icon represents the direction the selection will move. Selections move one pixel each time you press an arrow
key.
Button
Nudge Up
Nudge Down
Nudge Left
Nudge Right

Function
Moves all selected components up one pixel.
Moves all selected components down one pixel.
Moves all selected components one pixel to the left.
Moves all selected components one pixel to the right.

Size Toolbar
Use the Size toolbar to set all of the components within a selection to a uniform height or width.
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Button

Function
Determines the minimum width of all selected components, then sets the width of

Shrink Width to

the components to that value.

Smallest

Determines the maximum width of all selected components, then sets the width of

Grow Width to

the components to that value.

Largest
Shrink Height to
Smallest
Grow Height to
Largest

Determines the minimum height of all selected components, then sets the height of
the components to that value.
Determines the maximum height of all selected components, then sets the height of
the components to that value.

Draw Toolbar
Use the Draw toolbar to set the color and style used by shape, line, and region components.
Button
Fill Color
Line Color
Line Thickness
Line Style

Function
Sets the color for a shape or region.
Sets the color of the border for shapes and regions. Sets the color for a line.
Determines the thickness of a line. Applies to line components only.
Sets the style of a line.

Align or Space Toolbar
The Align or Space toolbar is useful when components need to be positioned uniformly. For example, you can
use it to align several components so that the tops are all even, or you can space components so that they have
an equal amount of space between them. The first component selected determines the position to which the
others align.
Button
Align Left
Align Middle

Function
Aligns a group of components with the leftmost position of the component selected first.
Centers a group of components based on the horizontal center of the component
selected first.
Aligns a group of components with the rightmost position of the component selected first.
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Button

Function

Align Right
Edges
Align Top
Align Center

Align Bottom

Aligns a group of components with the topmost position of the component selected first.
Aligns a group of components based on the vertical center of the component selected
first.
Aligns a group of components with the bottommost position of the component selected
first.
Spaces a set of components based on the leftmost position of the component selected

Space

first and the rightmost position of the component selected last.

Horizontally

Spaces a set of components based on the topmost position of the component selected

Space

first and the bottommost position of the component selected last.

Vertically

Centers a component horizontally within a band.

Center
Horizontally in
Band

Centers a component vertically within a band.

Center
Vertically in Band

Standard Component Palette
The icons on the Standard Component Palette represent components that are frequently used to build reports.
To create a component, click an icon and then click in a band.
Button
Select
Object
Label
Memo

Function
Selects one or more components within the layout. Also clears any selection (by clicking in the
white space of a band).
Displays text. Use the edit toolbar to set the caption of a label.
Prints multiple lines of plain text in a report.
Prints formatted text.

RichText
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Button

Function
Displays common report information such as page number, page count, print date and time, and

System

current date and time.

Variable
Performs calculations.
Variable
Displays graphics such as bitmaps, GIFs, and JPEGs.
Image
Displays various shapes, such as squares, rectangles, circles, and ellipses. Use the Edit toolbar
Shape
Line

to set the shape type.
Displays a line. Use the Edit toolbar to set the line orientation.
Renders barcodes. Use the Edit toolbar to set the data to be encoded. Right-click and select

BarCode
ACS
Variable

Configure to select bar code types.
Inserts the name of the report you are designing if you are using a pre-designed ACS report. If
you are creating a new report, inserts the text "ACS Report Designer Report."
Displays a Check Box component. Use the Edit toolbar to select the type of check box that you

CheckBox

want. Right-click and select Checked to change the marked or unmarked value.

Data Component Palette
This palette offers several components that are identical to ones in the standard palette, except for one thing:
they are data-aware.
Data-aware components have the ability to read the value of a field from a database table, and then display that
value in the report. This is different from the standard components, which display the content assigned when you
lay out a report. You associate a data-aware component with a given database table and field by selecting the
data pipeline and the data field from the drop-down lists in the edit toolbar.
Button
DBText

Function
Displays data from most types of database fields. Cannot handle images or rich text.
Prints plain text from a memo field of a database table. It automatically word-wraps the text.

DBMemo
Prints formatted text from a memo field. It automatically word-wraps the text.
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Button

Function

DBRichText
Performs simple database calculations (Sum, Min, Max, Average, Count).

DBCalc

Prints graphics (Bitmaps, GIFs, JPEGs) that are stored in a database field. For example,
individual and family photos.

RDDBImage

Converts the data from a database field to a barcode symbol.
DBBarCode
Displays a Check Box component for the selected database field. Right-click and select
DBCheckBox

Settings to define the style and Boolean values for the check box.

Advanced Component Palette
The Advanced Component Palette contains components that can help you tackle complex reporting
requirements.
Button

Function
Logically groups components together.

Region
Handles multiple master details, creates side-by-side reporting effects, and hooks reports
SubReport

together as one.
Allows you to generate a set of calculations that summarize the data from a database table. It

CrossTab

displays the calculations in a grid format.

Report Tree
Use the Report Tree to view the components within each band. Components you select in the Report Tree
become the selection in the report layout. You can select multiple components by holding down the Ctrl key and
clicking on each name. You can rename components by right-clicking over the name, selecting Rename, and
then typing in a new name. Make sure to press the Enter key after renaming to ensure that the new name is
assigned.
This tool window is dockable only on the left and right sides of the design workspace.
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Data Tree
Use the Data Tree to create data-aware components within a band. Simply select a set of fields and drag the
selection into the band. A set of corresponding data-aware components is created. This tool window is dockable
only on the left and right sides of the design workspace.
Area

Function

Data

Shows all of the data pipelines in the data workspace. Data pipelines represent a database table or

List

SQL query and provide a set of data structured as records and fields.

Field

Shows the fields for the currently selected data pipeline.

List
Data

Shows what data is available for the report.

Tab
Layout Allows you to control the format of the components created when you drag fields from the Data Tree
into the layout.
Tab

Standard Toolbar
Use the Standard toolbar to perform basic functions such as opening, saving, and printing reports, as well as
cutting and pasting selections.
Button
New
Open
Save
Page Setup

Print
Print

Function
Creates a blank report.
Displays the Open dialog used to open an existing report.
Saves a report to file.
Displays the Page Setup dialog used to set the paper size and configure the layout for the
report.
Displays the Print dialog before sending the report to the printer.
Displays the Print Preview window.

Preview
Cut

Copy

Places the currently selected components in the clipboard and removes them from the
report layout.
Copies the currently selected components into the clipboard.
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Button

Function

Paste

Pastes the components in the clipboard into the report layout.

Format Toolbar
Use the Format toolbar to set the font and colors of text-based components. You can also control the layering of
components with this toolbar.
Button

Function
Shows the name of the font chosen for the selected component.

Font
Font Size
Bold
Italic
Underline
Left Justify
Center
Right Justify
Font Color
Highlight Color
Bring to Front
Send to Back

Shows the size of the font chosen for the selected component.
Sets text to bold.
Sets text to italic.
Underlines text.
Left justifies text.
Centers text.
Right justifies text.
Sets the text color.
Sets the background color.
Brings a component to the front of other components.
Sends a component to the back of the other components. Use the Report Tree to
see the exact layering of the components within the band.

Edit Toolbar
The Edit toolbar changes based on the selected component. You can use it with the following components:
data-aware components
labels
shapes
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lines

Data-aware Component
Use the Edit toolbar to set the data pipeline and data field for a data-aware component. The drop-down list on
the left shows the data pipelines. The drop-down list on the right shows the field names.

Labels
Use the Edit toolbar to type the text for a label component.

Shapes
Use the Edit toolbar to choose from a list of shapes when a shape component is selected.

Lines
Use the Edit toolbar to move the line to the top, bottom, left, or right within a line component.
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Report Quick Design Tools
The Report Designer offers tools to assist you with some of the more difficult report-building processes. These
tools are:
Query Wizard
Query Designer
Report Wizard
Label Templates
ACS Report Templates
CrossTab Wizard

Query Wizard
The Query Wizard is a tool that you can use to access information from your database to use in a report. The
Query Wizard is accessed from the Data workspace by selecting File | New, and then double-clicking Query
Wizard. Follow the instructions given on each window of the Query Wizard to select data.
The Data workspace can be used to select and manipulate data for a given report. In most cases, you will not
need to use the Data workspace when you work in the Report Designer because the Report Designer interfaces
with ACS Advanced Export to select data for your report. You can use an existing Advanced Export or create
a new one, depending on your reporting needs. This method of data selection simplifies the query process and
makes it easier to select data without an in-depth knowledge of databases. Using ACS Advanced Export to
select data eliminates the need to use the query functionality of the Data workspace when you are designing
your report.

Query Designer
The Query Designer is used to modify query-based dataviews. The Query Designer presents a series of
notebook tabs; each tab represents a different part of the query. You can use the Query Designer to add or
remove search criteria from your query.
The Data workspace can be used to select and manipulate data for a given report. In most cases, you will not
need to use the Data workspace when you work in the Report Designer because the Report Designer interfaces
with ACS Advanced Export to select data for your report. You can use an existing Advanced Export or create
a new one, depending on your reporting needs. This method of data selection simplifies the query process and
makes it easier to select data without an in-depth knowledge of databases. Using ACS Advanced Export to
select data eliminates the need to use the query functionality of the Data workspace when you are designing
your report.
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Report Wizard
The Report Wizard is accessed from the File | New menu option of the Design workspace. A series of windows
is presented, each requesting information about the report. When the last page is reached, you can select either
a preview or design option. When you click Finish, the report is created and displayed as requested.

Label Templates
The Label Templates wizard is accessed from the File | New menu option of the Design workspace. The Label
Template window displays requesting information about the labels you want to print. You can select the type of
labels to print on the Products section of this window. Select the appropriate printer and product information
and click OK to work with a label template.

ACS Report Templates
ACS has provided a report template that you can use when you are designing a new report. The template
includes a Header band with the date, time, church name, and page number. When you select the ACS Report
Template, the Design workspace is accessed with the template in place.

CrossTab Wizard
The CrossTab Wizard is accessed from the File | New menu option of the Design workspace. A series of
windows is presented, each requesting information about the report data and the crosstab layout you want to
use. When the last page is reached, either a preview or design option can be selected. When you click Finish, a
report is created and displayed as requested.
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Suppressing a Blank Line in Report Designer
On some reports, you may want to keep lines from printing when there is no data in a field. For example, if you
print a report that includes the names and addresses for mailing labels, you may not want a blank line to print for
each address that does not include an Address Line 2. You can suppress the printing of a blank line using
DBMemo components and the ShiftRelativeTo... option.
The following procedures walk you through creating a sample report and suppressing Address Line 2 when the
field is blank.
To create a new report
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer and click Go

.

3. In the Report Type list, select the People report type, then select Create a New Report.
4. In the lower sidebar, click Customize.
5. Click Get Report Data > Create a Data Export.
6. In the Select Export Type window, select Database Export and then click OK. The ACS Data Export
Designer window displays.
7. On the Groups tab, select People.
8. Click on the Included Data tab, select Personal, then click Save & Close.
9. In the Refresh Export window, enter the number of records you want to limit the export to and then click
OK.
10. On the Report Options tab, click Design Report.
11. In the New Items window, click Cancel.
Now you can select the name and address fields for the sample report.

To select the name and address fields for the report
1. In the design workspace, resize the Detail band to one inch high.
2. Click DBText

.

3. Click in the Detail band to place a DBText component in the report.
4. In the Data Field list, select IndividualLabelName.
5. Click DBMemo

.

6. Click in the Detail band to place a DBMemo component in the report.
7. Size the DBMemo component to the same height as the DBText component.
8. In the Data Field list, select Address1.
9. Place another DBMemo component in the report. In the Data Field list, select Address2.
10. Place a third DBMemo component in the report. In the Data Field list, select CityStateZip-Formatted.
11. Place these fields one below the other, spaced evenly, and align them at the left edge.
The Detail band of your report should look similar to this:
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If your Address2 field contains the text DBMemo2, the first record in your export file does not have data in the
Address Line 2 field.
Click the Preview tab to preview the report. Addresses that do not have data in Address Line 2 display a blank
line where that data would be. The report should look similar to this:

Now you can suppress the blank lines in the addresses

To suppress blank lines in the addresses
1. In the design workspace, right-click the DBMemo3 component, which contains the
CityStateZIP-Formatted field.
2. Select ShiftRelativeTo....
3. In the Set object position based on list, select DBMemo2
4. Click OK.
5. Right-click the DBMemo2 component, which contains the Address2 field.
6. Select ShiftRelativeTo....
7. In the Set object position based on list, select DBMemo1
8. Click OK.
Click the Preview tab to preview the report. The blank line is now removed in addresses that do not have data in
Address Line 2. The report should look similar to this:
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Useful Information
Suppressing blank lines only works when you have components placed vertically. You cannot remove
blank horizontal spaces by suppressing components with no data.
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Saving Designed Reports
When you create a new report using Report Designer, you can save it to use again.

Organizing Saved Reports
To avoid a long list of reports that are difficult to distinguish from one another, you can organize reports
into their types.
Before you create a new report, in the upper sidebar of the reports window, select the type of report
you are creating. For example, Attendance or Contributions. Then, select Create a New Report and
click Customize. This ensures that the new report is listed under the report type you selected.
For example, you want to create a custom Balance Sheet of your assets and liabilities. This is an
example of a General Ledger report. To save this report under the proper type, double-click General
Ledger before selecting Create a New Report. When you save the report, it is located under General
Ledger in the reports window.

To save a designed report
1. Once you have designed the report, close the ACS Report Designer window.
2. In the People Suite Reports window, click Preview.
3. In the preview window, on the reports toolbar, click Save.
4. Enter a new name for the report.
5. To make the report available to other ACS users, select Public.
6. Click Save.
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Saving Report Designer Templates
If you create a report layout that you want to use for other reports, you can save it as a report template. For
example, if you have several reports you want to use a similar Header for, you can save the header and open it
through ACS Templates.
To save a report template
1. Create the report layout in the ACS Report Designer.
2. Click File, then click Save As Report Template.
3. In the Save As Report Template window, enter the Template Name.
4. Select a Category for the template. To add a new category, enter the new category name in this field.
5. Click Save.

To open a saved report template
1. Access the ACS Report Designer.
2. Click the Design tab.
3. Click File, then New.
4. In the New Items dialog box, select ACS Report Templates.
5. Click the tab that corresponds with the category the template is saved in.
6. Select the template and then click OK.
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Importing and Exporting Designed Reports
Report Designer lets you import reports created by another user. When you import the report, all settings,
including the associated data export settings, also import. Once the file is imported, you can open it in Report
Designer for use or modification.

Note
You can only import reports that have been successfully exported from Report Designer.
If you try to import a report file that hasn't been exported, a message displays indicating that the report
file (.rtm) does not contain a valid version number.

To import a report
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer and click Go.
3. In the upper sidebar, select Create a New Report.
4. In the lower sidebar, click Customize.
5. On the Report Options tab, under Design the Report, click Import Report.
6. Navigate to the report and click Open.
7. A message displays indicating the last time the exported data was refreshed and gives an option to limit
the number of records exported. Do one of the following:
To export all data and refresh it, click Yes.
To limit the number of records exported, enter the maximum number of records to export and click
Yes.
To refresh the data or limit the number of records exported, click No.

To export a report
1. Under Searches and Reports, click the Reports tab.
2. In the drop-down list, select Report Designer and click Go.
3. In the upper sidebar, select the report.
4. In the lower sidebar, click Customize.
5. On the Report Options tab, under Design the Report, click Export Report.
6. Navigate to the location where you want to save the report.
7. Click Save.
The report is exported to the selected location.
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